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5 Adobe Acrobat Reader
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7 Finding Words
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9  You can use the Find command to find a complete word or part of a word in the current PDF
10 document. Acrobat Reader looks for the word by reading every word on every page in the file,
11 including text in form fields.

12

13 To find a word using the Find command:

14

15 1. Click the Find button (Binoculars), or choose Edit > Find.

16 2. Enter the text to find in the text box.

17 3. Select search options if necessary:

18 Match Whole Word Only finds only occurrences of the complete word you enter in
19 the box. For example, if you search for the word stick, the words tick and sticky will
20 not be highlighted.

21

22 Match Case finds only words that contain exactly the same capitalization you enter in
23 the box.

24

25 Find Backwards starts the search from the current page and goes backwards through
26 the document.

27 4. Click Find. Acrobat Reader finds the next occurrence of the word.

28

29 To find the next occurrence of the word, Do one of the following:

30

31 Choose Edit > Find Again

32 Reopen the find dialog box, and click Find Again.

33 (The word must already be in the Find text box.)

34

35  Copying and pasting text and graphics to another application

36

37  You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it

38 into another application such as a word processor. You can also paste text into a PDF

39 document note or into a bookmark. Once the selected text or graphic is on the Clipboard, you
40 can switch to another application and paste it into another document.

41

42 Note: If a font copied from a PDF document is not available on the system displaying the
43 copied text, the font cannot be preserved. A default font is substituted.

44

45
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To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:
To select a line of text, select the first letter of the sentence or phrase and drag to
the last letter.

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option
(Mac OS) as you drag across the width of the document.

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command
(Mac OS) as you drag the length of the document.

To select all the text on the page, choose Edit > Select All. In single page mode, all the text
on the current page is selected. In Continuous or Continuous — facing mode, most of the text
in the document is selected. When you release the mouse button, the selected text is
highlighted. To deselect the text and start over, click anywhere outside the selected text.
The Select All command will not select all the text in the document. A workaround for this
(Windows) is to use the Edit > Copy command. Choose Edit > Copy to copy the selected
text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the
Show Clipboard command until it is installed. To install the Clipboard Viewer, Choose
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows
Setup tab. Double-click Accessories, check Clipboard Viewer, and click OK.
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[REPORT OF ACTION TAKEN IN CLOSED SESSION

TUESDAY FEBRUARY 1, 2011, BEGINS ON PAGE 167]

SUP. ANTONOVICH, MAYOR: THE MEETING WILL BEGIN BY A PRAYER OF
DR. RICHARD HORTON, PASTOR OF THE PARK HILLS COMMUNITY CHURCH
IN THE SECOND SUPERVISORIAL DISTRICT AND THE PLEDGE OF
ALLEGIANCE WILL BE LED BY JOSE MANUEL JARA OF THE VETERANS
WORK STUDY LOS ANGELES COUNTY MILITARY VETERANS AFFAIRS FROM
THE FIRST SUPERVISORIAL DISTRICT. SO IF THE AUDIENCE WOULD

PLEASE RISE.

DR. RICHARD L. HORTON: I'D LIKE TO THANK THE HONORABLE MARK
RIDLEY-THOMAS FOR INVITING ME, FOR MY INTRODUCTION BY THE
HONORABLE MICHAEL ANTONOVICH, AND FOR YOUR KIND ACCEPTANCE OF
THE SUPERVISORS. SHALL WE PRAY? ETERNAL AND GRACIOUS SPIRIT,
WHOM WE CALL BY DIFFERENT NAMES AND YET ALL EXPERIENCE AS THE
SAME NURTURING LOVE, REDEEMING GRACE, NEEDFUL MERCIES AND
RENEWING STRENGTH. WE THANK YOU FOR ALL YOUR BLESSINGS.
ESPECIALLY DO WE THANK YOU THAT YOU HAVE PROVIDED FOR US
PERSONS OF STYLE AND SUBSTANCE, PROMISE AND PERFORMANCE,
INTENTION AND IMPLEMENTATION TO SERVE AS LOS ANGELES COUNTY
SUPERVISORS. CONTINUE, WE PRAY, TO INSPIRE THEIR THOUGHTS,

PERVADE THEIR IMAGINATIONS AND SUGGEST THEIR DECISIONS SO THAT
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1 CONTINUING TO SERVE GRACIOUSLY, EFFECTIVELY AND POWERFULLY,
2 YOUR GLORY WILL BE REVEALED AND THE NEEDS OF THE PEOPLE THEY

3 SERVE MET. ON BEHALF OF FAITH, HOPE AND LOVE I PRAY, AMEN.

5 JOSE MANUEL JARA: PLEASE FACE THE FLAG AND FOLLOW ME IN THE
6 PLEDGE OF ALLEGIANCE. PLACE YOUR HAND OVER YOUR HEART. READY,

7 BEGIN. [PLEDGE OF ALLEGIANCE RECITED.]

9 SUP. ANTONOVICH, MAYOR: SUPERVISOR MARK RIDLEY-THOMAS?

10

11 SUP. RIDLEY-THOMAS: WE THANK YOU, MR. MAYOR. AND WE'RE

12 DELIGHTED TO HAVE WITH US TODAY DR. RICHARD HORTON, WHO SERVES
13 AS THE PASTOR OF THE PARK HILLS COMMUNITY CHURCH. HE WAS

14 ORDAINED AS AN EPISCOPALIAN PRIEST IN 1971 AND THEN AS A

15 BAPTIST MINISTER IN 1987. HE HOLDS A BACHELOR OF ARTS DEGREE
16 FROM TEXAS COLLEGE, A MASTER OF ARTS DEGREE FROM THE

17 UNIVERSITY OF WISCONSIN, A DOCTORATE OF MINISTRY FROM THE

18 CLAREMONT SCHOOL OF THEOLOGY. HE WAS THE FOUNDING PASTOR OF
19 THE ETERNAL PROMISE BAPTIST CHURCH. AND WHILE AT ETERNAL

20 PROMISE, HE TRAVELED ACROSS THE LENGTH AND BREADTH OF THE

21 WORLD TO SPEAK. HE'S ALSO ENGAGED IN A NUMBER OF NOT SIMPLY
ECUMENICAL LEADERSHIP INITIATIVES, BUT INTERFAITH EXCHANGES
WITH SEVERAL SYNAGOGUES IN THE LOS ANGELES AREA AND BEYOND.
HE'S HELD LEADERSHIP POSITIONS IN NOTED ORGANIZATIONS SUCH AS

THE PROGRESSIVE NATIONAL BAPTIST CONVENTION AND THE LOS
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1 ANGELES CHAPTER OF THE SOUTHERN CHRISTIAN LEADERSHIP

2 CONFERENCE WHERE HE SERVED IN LEADERSHIP POSITIONS WHILE I WAS
3 THERE AS THEIR EXECUTIVE DIRECTOR. HE IS A MAN OF FAITH, A MAN
4 OF VISION, A MAN OF INTELLECT, WHICH HE BRINGS TO BEAR TO HIS
5 PARISHIONERS AS WELL AS TO THOSE WHO ARE ENGAGED IN THE CIVIC
6 PROCESS. AND SO DR. HORTON, WE APPRECIATE YOUR BEING HERE

7 TODAY AND IT'S ON BEHALF OF THE ENTIRETY OF THE LOS ANGELES

8 COUNTY BOARD OF SUPERVISORS THAT WE PRESENT YOU WITH THIS

9 CERTIFICATE OF APPRECIATION. DR. RICHARD L. HORTON.

10 [APPLAUSE. ]

11

12 SUP. ANTONOVICH, MAYOR: SUPERVISOR MOLINA?

13

14 SUP. MOLINA: THANK YOU. IT'S MY HONOR THIS MORNING TO PRESENT
15 A CERTIFICATE OF APPRECIATION TO JOSE MANUEL JARA. MR. JARA

16 SERVED AS A SERGEANT IN THE FIRST ARMORED DIVISION OF THE

17 UNITED STATES ARMY FROM 2002 TO 2006. HE COMPLETED TWO TOURS
18 OF DUTY TO IRAQ. AND HIS IMPRESSIVE DECORATIONS INCLUDE THE

19 ARMY COMMENDATION MEDAL, AN INFANTRY BADGE AN IRAQ CAMPAIGN

20 MEDAL, A GOOD CONDUCT MEDAL, A NATIONAL DEFENSE SERVICE MEDAL
21 AS WELL AS A GLOBAL WAR ON TERRORISM MEDAL, AND AN ARMY

22 SERVICE MEDAL. WE WANT TO EXTEND OUR HEARTFELT GRATITUDE TO

23 JOSE FOR HIS TREMENDOUS SERVICE TO OUR COUNTRY AND TO ALL OF
24 US. CONGRATULATIONS. [APPLAUSE.]

25
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CLERK SACHI HAMAI: GOOD MORNING, MR. MAYOR, MEMBERS OF

BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 3, AGENDA FOR THE
MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D

THROUGH 3-D.

SUP. ANTONOVICH, MAYOR: MOTION BY SUP. MARK RIDLEY-THOMAS,

SECOND WITHOUT OBJECTION, SO ORDERED.

CLERK SACHI HAMAI: AGENDA OF THE MEETING OF THE REGIONAL PARK

AND OPEN SPACE DISTRICT, ITEM 1-P.

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR KNABE, SECONDED

WITHOUT OBJECTION, SO ORDERED.

CLERK SACHI HAMAI: ON PAGE 6, BOARD OF SUPERVISORS ITEMS 1-9.
ON ITEM NO. 1, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE
EXECUTIVE DIRECTOR OF THE LOS ANGELES COUNTY WORKEFORCE
INVESTMENT BOARD REQUESTS THAT THE REAPPOINTMENT OF TED
ANDERSON BE REFERRED BACK TO THIS BOARD. ON ITEM NO. 7,
SUPERVISOR YAROSLAVSKY REQUESTS THAT THIS ITEM BE CONTINUED
ONE WEEK TO FEBRUARY 8, 2011. AND THE REMAINING ITEMS UNDER
THE BOARD OF SUPERVISORS ARE BEFORE YOU. MOTION BY SUPERVISOR

MOLINA. SECONDED WITHOUT OBJECTION, SO ORDERED.
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1 CLERK SACHI HAMAI: ON PAGE 9, CONSENT CALENDAR, ITEMS 10
2 THROUGH 37. ON ITEM NO. 11, THE CHIEF EXECUTIVE OFFICER

3 REQUESTS THAT THIS ITEM BE REFERRED BACK TO THE ARTS

4 COMMISSION. ON ITEM NO. 12, THERE'S A REQUEST FROM A MEMBER OF
5 THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 13, THERE'S A

6 REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM
7 NO. 17, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD

8 THIS ITEM. ON ITEM NO. 20, THERE'S A REQUEST FROM A MEMBER OF

9 THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 24, THIS INCLUDES

10 THE REVISIONS AS INDICATED ON THE SUPPLEMENTAL AGENDA, AND

11 THERE IS ALSO A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD

12 THIS ITEM. ON ITEM NO. 27, SUPERVISOR ANTONOVICH ABSTAINS FROM
13 THE VOTE. ON ITEM NO. 34, THERE IS A REQUEST FROM A MEMBER OF

14 THE PUBLIC TO HOLD THIS ITEM.

15

16 SUP. KNABE: WHAT WAS THAT?

17

18 CLERK SACHI HAMAI: 34. ON ITEM NO. 36 THERE'S A REQUEST FROM A
19 MEMBER OF THE PUBLIC TO HOLD THIS ITEM. THE REMAINING ITEMS

20 UNDER THE CONSENT CALENDAR ARE BEFORE YOU.

21

SUP. ANTONOVICH, MAYOR: OKAY. MOTION BY SUPERVISOR MARK
RIDLEY-THOMAS. SECONDED BY KNABE, WITH ME ABSTAINING ON 27. SO

ORDERED.
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1 CLERK SACHI HAMAI: ON PAGE 20, ORDINANCE FOR INTRODUCTION, AND
2 I'LL READ THE SHORT TITLE IN FOR THE RECORD. THIS IS AN

3 ORDINANCE FOR INTRODUCTION AMENDING THE COUNTY CODE TITLE 3 -

4 ADVISORY COMMISSIONS AND COMMITTEES, TO EXTEND THE SUNSET

5 REVIEW DATE OF THE COMMISSION FOR WOMEN TO DECEMBER 1, 2013.

6 ON THIS ITEM, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO
7 HOLD IT. DISCUSSION ITEMS, ITEMS NO. 39 THROUGH 42. ON ITEM

8§ NO. 39, SUPERVISOR YAROSLAVSKY REQUESTS THAT THIS ITEM BE

9 CONTINUED ONE WEEK TO FEBRUARY 8, 2011.

10

11 SUP. ANTONOVICH, MAYOR: MOTION BY KNABE. SECONDED WITHOUT

12 OBJECTION, SO ORDERED.

13

14 CLERK SACHI HAMAI: ON ITEM NO. 40, AS INDICATED ON THE POSTED

15 AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE
16 CONTINUED TO MARCH 1, 2011.

17

18 SUP. ANTONOVICH, MAYOR: MOTION BY MOLINA. SECONDED WITHOUT

19 OBJECTION, SO ORDERED.

20

21 CLERK SACHI HAMAI: ON ITEM NO. 41, THE CHIEF EXECUTIVE OFFICER
22 REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO FEBRUARY 15,

2011.
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1 SUP. ANTONOVICH, MAYOR: MOTION BY MARK RIDLEY-THOMAS, SECONDED

2  WITHOUT OBJECTION, SO ORDERED.

4 CLERK SACHI HAMAI: ON ITEM NO. 42, THIS IS A PUBLIC HEARING
5 AND WE WILL HOLD IT FOR THE PUBLIC HEARING. ON PAGE 22,

6 MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE
7 THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE

8 SUPPLEMENTAL AGENDA. ITEM NO. 43-A.

10 SUP. ANTONOVICH, MAYOR: MOTION BY KNABE SECONDED WITHOUT

11 OBJECTION, SO ORDERED.

12

13 CLERK SACHI HAMAI: ON PAGE 25, NOTICES OF CLOSED SESSION, ON
14 ITEM NO. CS-4, SUPERVISOR YAROSLAVSKY REQUESTS THAT THIS ITEM
15 BE CONTINUED ONE WEEK TO FEBRUARY 8, 2011. CS-4. AND ALSO ON
16 PAGE 26, ITEM NO. CS-6, AS INDICATED ON THE POSTED AGENDA, THE
17 CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED
18 ONE WEEK TO FEBRUARY 8, 2011.

19

20 SUP. ANTONOVICH, MAYOR: MOTION BY MOLINA, SECONDED WITHOUT

21 OBJECTION, SO ORDERED.

CLERK SACHI HAMAI: AND THAT COMPLETES THE READING OF THE
AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH

SUPERVISORIAL DISTRICT NO. 3.
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SUP. ANTONOVICH, MAYOR: LET ME FIRST BRING UP THE CONSUL
GENERAL. LET US FIRST WELCOME THE CONSUL GENERAL FOR SPAIN.
ENRIQUE RUIZ MOLERO, WHO IS A SON OF A DIPLOMAT BORN IN
MOROCCO AND HAS LIVED IN VARIOUS COUNTRIES THROUGHOUT THE
UNITED STATES AND ITALY. AFTER EARNING HIS LAW DEGREE IN
MADRID, HE BEGAN HIS DIPLOMATIC CAREER, SERVING IN EMBASSIES
IN PANAMA, THE NETHERLANDS AND BRAZIL. IN SEPTEMBER OF 2000,
HE WAS APPOINTED AMBASSADOR OF SPAIN TO THE NORTHWEST AFRICAN
COUNTRY, MAURITANIA. AFTER THAT, HE WENT TO SOUTHERN FRANCE AS
CONSUL GENERAL OF SPAIN AND (INAUDIBLE). BEFORE ARRIVING IN
LOS ANGELES COUNTY, HE SERVED IN THE MINISTRY OF FOREIGN
AFFAIRS FOR THE DEPARTMENT OF ECONOMY AND PERSONNEL AND IN THE
DIPLOMATIC SCHOOL. SO ON BEHALF OF OUR 10-1/2 MILLION PEOPLE,
MR. AMBASSADOR, WE WANT TO WELCOME YOU TO L.A. COUNTY, WE LOOK
FORWARD TO WORKING WITH YOU. WE WERE HERE MANY YEARS AGO AND I
HAD THE PRIVILEGE OF MEETING YOUR KING AND QUEEN, JUAN CARLOS
AND SOPHIA. AND THEIR CHILDREN HAVE VISITED HERE MANY TIMES,
WHICH WE HAVE HOSTED. AND WE HAVE GOOD RELATIONSHIPS WITH

SPAIN AND WE WANT TO CONTINUE UPON IT. [APPLAUSE.]

HON. ENRIQUE RUIZ MOLERO: MAYOR ANTONOVICH, HONORABLE MEMBERS
OF THE BOARD OF SUPERVISORS, THANK YOU VERY MUCH FOR YOUR KIND
WORDS AND FOR YOUR VERY WARM RECEPTION. I WAS EXTREMELY HAPPY

WHEN I WAS APPOINTED CONSUL GENERAL OF SPAIN IN LOS ANGELES.
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1 AND I MUST SAY IT'S NOT MY FIRST TIME IN CALIFORNIA, BECAUSE I
2 HAD PREVIOUSLY VISITED THE STATE AS A TOURIST. BUT YOU CAN

3 IMAGINE I WAS EXTREMELY SATISFIED WHEN I WAS APPOINTED. THE

4 EXTREMELY GOOD RELATIONS BETWEEN SPAIN AND THE UNITED STATES

5 ARE WELL-KNOWN BY ALL OF YOU. OUR EMBASSY AND OUR NETWORK OF

6 CONSULATES IN THE UNITED STATES IS VERY BIG. IN FACT, WE HAVE
7 TWO OF THEM IN CALIFORNIA, SAN FRANCISCO AND L.A. AND WE ARE

8 TRYING TO DO OUR BEST TO SERVE THE COMMUNITY. THE SPANIARDS

9 LIVING IN L.A. ARE NOT VERY NUMEROUS, NOT MORE THAN 15,000.

10 SOME OF THEM MIGHT BE WELL-KNOWN TO YOU, SOME ARE HOLLYWOOD

11 STARS, SOME ARE N.B.A. STARS. BUT MOST OF THEM ARE HARD

12 WORKING PEOPLE, ENGINEERS, TEACHERS, BUSINESSMEN, CONTRIBUTING
13 TO THE WEALTH AND WELFARE OF THE COUNTY. I WOULD LIKE TO

14 ASSURE YOU THAT I WILL KEEP THE TRADITION OF EXCELLENT

15 RELATIONS WITH LOCAL AUTHORITIES AND THAT IN OUR CONSULATE,

16 THE CONSULATE OF SPAIN, WE WILL TRY TO DO OUR BEST TO SERVE

17 AND TO HELP ANY RESIDENT OF THE COUNTY OF L.A. THAT WISHES TO
18 ESTABLISH RELATIONS WITH SPAIN, PERSONAL RELATIONS, COMMERCIAL
19 RELATIONS, EDUCATIONAL RELATIONS, ET CETERA. THANK YOU VERY

20 MUCH. [APPLAUSE.]

21

22 SUP. ANTONOVICH, MAYOR: SUPERVISOR KNABE?

23
24 SUP. KNABE: THANK YOU, MR. MAYOR, MEMBERS OF THE BOARD, LADIES

25 AND GENTLEMEN. IT'S MY PRIVILEGE TO CALL UP OUR 2010 LOS

The Meeting Transcript of
The Los Angeles County Board of Supervisors
12



February 1, 2011

The Meeting Transcript of
The Los Angeles County Board of Supervisors

1 ANGELES COUNTY PUBLIC LINKS GOLEF ASSOCIATION JUNIOR GOLF
2 CHAMPIONS. THE DEPARTMENT OF PARKS AND RECREATION HOSTED THE

3 LOS ANGELES COUNTY PUBLIC LINKS GOLEF ASSOCIATION, OUR ANNUAL

4 JUNIOR GOLF CHAMPIONSHIP FOR THE FIFTH YEAR. A RECORD 1700

5 GOLFERS COMPETED IN FIVE EVENTS WITH 123 QUALIFIERS CONTESTING
6 IN THE CHAMPIONSHIP FINAL. ONE QUALIFYING EVENT IS HELD IN

7 EACH SUPERVISORIAL DISTRICT, AND THE CHAMPIONSHIP FINAL IS

8 ROTATED EACH YEAR. THIS IS A TRUE LOS ANGELES COUNTY EVENT,

9 AND THIS YEAR WAS HELD AT EL CARISO GOLE COURSE IN SUPERVISOR
10  YAROSLAVSKY'S DISTRICT. I WOULD ALSO LIKE TO THANK THE PUBLIC
11 LINKS GOLF ASSOCIATION, MR. CRAIG KESTLER FOR HIS ONGOING

12 SUPPORT. THEY HAVE SINCE MERGED WITH THE SOUTHERN CALIFORNIA
13 GOLF ASSOCIATION. WE'VE GOT KEVIN HENEY AS WELL HERE TOO. AND
14 I'M SURE THAT KEVIN AND CRAIG TOGETHER ARE GOING TO CONTINUE A
15 STRONG WORKING RELATIONSHIP WITH OUR JUNIOR GOLEF PROGRAM. ALSO
16 ROGER DUNN GOLF SHOPS, MR. JUNIOR GOLF, MR. WOMEN'S GOLF AND
17 THAT'S MR. LEN KINNET WHO FOR 50 YEARS AGO HAS SUPPORTED

18 JUNIOR GOLF AND WOMEN'S GOLF. HE'S ALWAYS OUR HONORARY STARTER
19 AND HAS BEEN A LIFETIME JUNIOR GOLEF ADVOCATE. AND ALL OF OUR
20 GOLF COURSE LESSEES WHO PROVIDE FREE RANGE BALLS AND THE USE
21 OF THE GOLF COURSE AT NO CHARGE. SO IT'S MY PLEASURE NOW TO

22 INTRODUCE OUR 2010 CHAMPIONS. FIRST OF ALL IN THE 14 TO 15 AGE

23 BRACKET, WE HAVE MR. DEAN SAKATA OF DIAMOND BAR. HE HAD A
24 FINAL ROUND SCORE 62 UNDER PAR, WON THE THREE-HOLE SUDDEN

25 DEATH PLAYOFF. [APPLAUSE.] NEXT IN THE BOYS 11 AND UNDER, ALL
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1 THE WAY FROM PALM DESERT, CHARLES REITER. HE HAD A FINAL ROUND
2 SCORE OF 28, 3 UNDER PAR, A FOUR-STROKE VICTORY. AND IF YOU

3 SEE HIM, HE ALSO WON THE CATEGORY OF BEST DRESSED. HE HAS

4 THOSE PAYNE STEWART KNICKERS ON. IS THIS KID SHARP OR WHAT?

5 [APPLAUSE.] I STAND CORRECTED. REITER. NEXT IN THE GIRLS 15 TO
6 18, KATHERINE GUO FROM ARCADIA, FINAL ROUND 66, A ONE-STROKE

7 VICTORY. HER HOME COURSE IS SANTA ANITA. [APPLAUSE.] IN THE

8 GIRLS 12-14, ROBYNN REE OF REDONDO BEACH. FINAL ROUND SCORE OF
9 61, 1 UNDER PAR, A THREE-STROKE VICTORY THAT INCLUDED A HOLE
10 IN ONE ON NO. 17. [APPLAUSE.] I NONCHALANTLY ASKED IS THAT

11 YOUR FIRST? BECAUSE I'M BEGGING FOR MY FIRST. SHE SAID NO,

12 THIS IS HER THIRD ONE. MAKE ME FEEL BAD. ALL RIGHT. GIRLS 11
13 AND UNDER, BELLA SETIO FROM SAN MARINO. FINAL ROUND SCORE 31
14 EVEN PAR. SHE PLAYED IN ALL FIVE QUALIFIERS PRIOR TO WINNING
15 THE CHAMPIONSHIP. [APPLAUSE.] HAVE YOU HAD A HOLE IN ONE?

16 WE'RE GOING GET A GROUP PHOTO HERE. SO ON BEHALF OF MY

17 COLLEAGUES ON THE BOARD AND ALL OF OUR RESIDENTS, IT'S MY

18 HONOR AND PRIVILEGE TO ONCE AGAIN CONGRATULATE OUR 2010 COUNTY
19 PARKS AND REC JUNIOR GOLE ASSOCIATION CHAMPIONS. AND, AGAIN, A
20 GREAT THANK YOU TO ALL THOSE THAT MADE IT POSSIBLE. LET'S GIVE
21 THEM A ROUND OF APPLAUSE. [APPLAUSE.] I GUESS THIS IS GOLF
DAY. EVERYBODY WORKED OUT FOR EVERYBODY'S SCHEDULE, BUT WE'RE
GOING TO BRING REPRESENTATIVES FORWARD AT THIS POINT FROM
AMERICAN GOLEF ASSOCIATION, AMERICAN GOLEF CORPORATION, EXCUSE

ME, LA MIRADA GOLF COURSE AND OUR PARKS AND REC FOLKS. AND
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1 FROM AMERICAN GOLF, WE HAVE CHIEF OPERATING OFFICER KEITH
2 BROWN AND REGIONAL DIRECTOR WARREN LEERY. FROM THE LA MIRADA

3 GOLF COURSE, WE HAVE GENERAL MANAGER HOLDEN KIM, ASSISTANT

4 GENERAL MANAGER GLEN CHOU. SUPERINTENDENT SERGIO SAHAGUN, FOOD
5 AND BEVERAGE DIRECTOR ELIZABETH SANCHEZ, HEAD PROFESSIONAL

6 JOHN MAHONEY AND FROM OUR PARKS AND REC, WE HAVE RUSS GUINEY

7 AND GOLEF OPERATIONS MANAGER GEORGE BIDDELL AND HIS STAFF.

8§ AMERICAN GOLEF CORPORATION HAS OPERATED LA MIRADA COUNTY GOLF

9 COURSE SINCE MAY OF 1982, AND THEY HAVE INVESTED IN MANY, MANY
10 CAPITAL IMPROVEMENTS AT THE FACILITY. LA MIRADA GOLEF COURSE

11 HAS WON THE HONOR OF LOS ANGELES COUNTY GOLFE COURSE OF THE

12 YEAR SIX TIMES IN THE 19-YEAR HISTORY OF THIS AWARD. LA MIRADA
13 HAS PROVIDED MANY SERVICES TO THE COMMUNITY AND GOLFERS ALIKE,
14 INCLUDING HOSTING TOURNAMENTS FOR SEVERAL LOCAL CHARITIES,

15 ACTING AS A HOME COURSE FOR MANY AREA HIGH SCHOOL GOLFEF TEAMS,
16 AND OFFERING ONE OF THE FINEST PRO SHOPS IN OUR COUNTY GOLF

17 SYSTEM. IT AVERAGES MORE THAN 120,000 ROUNDS OF GOLF PER YEAR
18 DURING THE LAST 28 YEARS. THE GOLF COURSE MANAGEMENT OUT AT LA
19 MIRADA AND THEIR STAFF HAVE CONTINUED TO DISPLAY EXCELLENT AND
20 CONSISTENT PERFORMANCE IN GOLEF COURSE OPERATIONS AND

21 MAINTENANCE PROGRAMS, AND ONCE AGAIN IN 2010, THEY HAVE

22 ACHIEVED THE DESIGNATION AS THE LOS ANGELES COUNTY GOLE COURSE
OF THE YEAR FOR PROVIDING HIGH QUALITY MAINTENANCE AND
OUTSTANDING CUSTOMER SERVICE DURING THE YEAR. SO ON BEHALFE OF

THE BOARD, MY COLLEAGUES AND THE 10 MILLION PLUS RESIDENTS AND

The Meeting Transcript of
The Los Angeles County Board of Supervisors
15




The Los Angeles County Board of Supervisors

February 1, 2011

The Meeting Transcript of

10

11

12

13

14

15

16

17

18

19

20

21

THE MANY GOLFERS THAT USE THIS FINE FACILITY EACH AND EVERY
YEAR, IN THE COUNTY WE HAVE 306 HOLES OF GOLF SPREAD
THROUGHOUT ALL OF LOS ANGELES COUNTY. SO THIS IS A BIG AWARD
FOR THEM, SORT OF A PEER AWARD. SO TO AMERICAN GOLE AND TO THE
STAFE OF LA MIRADA, CONGRATULATIONS AS GOLE COURSE OF THE
YEAR. [APPLAUSE.] ALL RIGHT. LET'S SEE. (OFF MIC.) WE'LL GET A

GROUP PHOTO HERE. RUSS, DO YOU WANT TO SAY A FEW WORDS?

RUSS GUINEY: I WANT TO CONGRATULATE AMERICAN GOLF AND LA
MIRADA GOLF COURSE STAFF. THE COUNTY OPERATES THE LARGEST
MUNICIPAL GOLF COURSE SYSTEM IN THE NATION WITH 19 GOLF
COURSES WHERE 1-1/2 MILLION PEOPLE PLAY, PAYING THE LOWEST
GREEN FEES IN ALL OF SOUTHERN CALIFORNIA. WE HAVE AN
AGGRESSIVE CAPITAL IMPROVEMENT PROGRAM, WE HAVE A SENIOR
DISCOUNT PROGRAM, WE HAVE A TRAVELING GOLF CLUB AND WE HAVE A
FREE JUNIOR GOLEF PROGRAM. WE HAVE THE FINEST GOLE STAFF IN THE
NATION, I WANT TO SALUTE THEM, AND THE FINEST GROUP OF
OPERATORS. AND WE THANK YOU FOR THE GREAT JOB YOU DO AND THE

SUPPORT FOR OUR ENTIRE PARKS SYSTEM. THANK YOU. [APPLAUSE.]

SUP. KNABE: JUST ONE POINT OF RECOGNITION. ALSO JOINING US
TODAY FROM LA MIRADA, LA MIRADA HIGH SCHOOL, HAVE OUR YOUTH IN
GOVERNMENT GROUP, PART OF THEIR YOUTH IN GOVERNMENT PROGRAM OF
RUNNING CITY HALL BUT ALSO VISITING THE COUNTY. I'M GOING TO

ASK THEM TO STAND UP. WELCOME. CONGRATULATIONS. THANKS FOR
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1 BEING DOWN HERE. [APPLAUSE.] THEY ELECT MAYOR AND CITY COUNCIL
2 AND THEY ACT AS AN ADVISORY GROUP DURING THIS PROGRAM TO THE
3 CITY COUNCIL IN LA MIRADA. SO WE APPRECIATE YOUR PARTICIPATION

4 IN LOCAL GOVERNMENT. KEEP UP THE GOOD WORK. [APPLAUSE.]

6 SUP. ANTONOVICH, MAYOR: EACH YEAR I HOST A PROGRAM CALLED "ALL
7 FOR THE LOVE OF CHILDREN," WHICH RAISES FUNDS FOR THE CHILDREN
8 IN OUR DEPARTMENT OF CHILDREN AND FAMILY SERVICES. AND IT'S A
9 PUBLIC/PRIVATE OPPORTUNITY TO PARTICIPATE, RAISE FUNDS TO HELP
10 THOSE YOUNG PEOPLE WHO HAVE PROBLEMS AND SERVICES THAT ARE

11 REQUIRED THAT ARE NOT COVERED BY THE STATE OF CALIFORNIA. SO
12 WE WOULD JUST LIKE TO RECOGNIZE, THESE ARE THE INDIVIDUALS WHO
13 WERE THE SPONSORS TO MAKE THAT SUCH A WONDERFUL SUCCESS. THIS
14 YEAR IT WAS HELD AT THE ARBORETUM AND WE HAD ABOUT 700 PEOPLE.
15 SO AT THIS TIME, LET ME BRING UP FIRST, CALIFORNIA CULINARY

16 INSTITUTE CORDON BLUE PROGRAM, DEAN BLACKMAN. NOT HERE. OKAY.
17 THEY'RE PROBABLY IN THE KITCHEN. [LAUGHTER.] CHEF MARILYN SOUL
18 FOOD RESTAURANT, MARILYN COAL. [APPLAUSE.] OKAY, WE'LL BE

19 SERVING LUNCH IN THE BACK? [LAUGHTER.] AND WONDERFUL SUBWAY.
20 EVERYBODY'S FAVORITE. MANU SINGH, NOT HERE. NOW THAT THEY ARE
21 OPEN FOR BREAKFAST, THEY ARE PROBABLY WORKING. PASADENA

22 MAGAZINE, REBECCA HUSSING. [APPLAUSE.] GLORIA KING SOLOMON.
(APPLAUSE) . FROM WAL-MART, JORGE LOPEZ. NOT HERE. HERE?

[APPLAUSE.] FROM THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT,
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WE HAVE -- FROM THE JAILS ENTERPRISE UNIT, ADRIAN FREE.

PROBABLY IN JAIL, HUH? [LAUGHTER.]

ADRIAN FREE: WAL-MART. WAL-MART. OKAY.

SUP. ANTONOVICH, MAYOR: AND FROM AT&T, DAN RIBETTO. HE'S HERE.
AND FOR THE ONE CHILD AT A TIME, JACKIE SOLOMON AND LIBETTE
HAUTTIER. AND FROM SOUTHERN CAL EDISON, DAVID FORD. I DIDN'T

SEE DAVID. IS DAVID HERE?

SUP. RIDLEY-THOMAS: WHERE IS FORD WHEN YOU NEED HIM?

SUP. ANTONOVICH, MAYOR: YEAH, WHERE'S DAVID WHEN WE NEED HIM?
ANYWAY. AND THEN FINALLY FROM SAFETY KIDS UNLIMITED, KEVIN
ANDERSON. NOT HERE. OKAY. DID YOU GET YOURS. HERE THEY COME.
OKAY. SAFETY KIDS, RIGHT? STEVE, WHY DON'T YOU TAKE THE
SHERIFF'S ONE? YOU'RE DRESSED FOR THE OCCASION. [LAUGHTER.]
WAVE TO YOUR GRANDKIDS AT HOME. (OFF MIC.) [APPLAUSE.] NOW WE
WOULD LIKE TO INTRODUCE DR. CARRIE MILLER, WHO IS THE C.E.O.
IN RECOGNITION OF HER ACCOMPLISHMENTS AT THE HELM OF THE
EDUCATION COORDINATING COUNCIL TO IMPROVE THE EDUCATIONAL
ACHIEVEMENT AND ACADEMIC PERFORMANCE OF OUR COUNTY'S FOSTER
AID AND PROBATION YOUTH. ON MY NOVEMBER 2004 MOTION,
COAUTHORED BY SUPERVISOR YAROSLAVSKY, THE BOARD HAD CREATED

THE EDUCATIONAL COORDINATING COUNCIL. DR. MILLER HAS BEEN AN
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1 EDUCATION COORDINATING COUNCIL DIRECTOR FOR THE PAST TWO YEARS
2 AND HAS SERVED ON THE COUNCIL FOR THE PAST SIX YEARS. UNDER

3 HER LEADERSHIP THEY ELEVATED COUNTY-WIDE AWARENESS OF THE

4 SIGNIFICANT IMPACTS OF HIGH ACADEMIC EXPECTATIONS, RIGOROUS

5 EDUCATIONAL PLANNING AND A COLLABORATIVE SUPPORT SYSTEM UPON

6 THE STABILITY, EDUCATIONAL ACHIEVEMENT AND WELL-BEING OF OUR

7 COUNTY'S FOSTER YOUTH. HOWEVER, A WELL-DESERVED PROMOTION TO

8 THE POSITION OF ASSISTANT DIRECTOR OF THE SERVICE INTEGRATION
9 BRANCH WITHIN THE COUNTY'S C.E.O. OFFICE MEANS CARRIE WILL NOW
10 LEAVE HER POST AS THE DIRECTOR. AND SOME OF HER MAJOR

11 ACCOMPLISHMENTS FROM 2004-2010 HAVE INCLUDED: THE DEVELOPMENT
12 AND IMPLEMENTATION OF THE E.C.C.'S ACTION PLAN, EXPECTING

13 MORE, A BLUEPRINT FOR RAISING THE EDUCATIONAL ACHIEVEMENT OF
14 FOSTER AND PROBATION YOUTH, DOUBLED THE PERCENTAGE OF YOUNG

15 FOSTER CHILDREN PARTICIPATING IN HIGH QUALITY EARLY CHILDHOOD
16 EDUCATIONAL PROGRAMS FROM A 30 PERCENT TO NOW 60 PERCENT,

17 TRIPLED THE NUMBER OF AFTER SCHOOL ACADEMIC MENTORING AND

18 TUTORING PROGRAMS AT THE ELEMENTARY, THE MIDDLE SCHOOL AND

19 HIGH SCHOOL CAMPUSES FROM 14 PROGRAMS SERVING 807 STUDENTS TO
20 42 PROGRAMS NOW SERVING OVER 2,570 STUDENTS. SHE DEVELOPED A
21 FIRST-TIME EVER STATE AND NATIONALLY RECOGNIZED BEST PRACTICE
22 MECHANISM, ENABLING THE DIRECT SHARING OF SCHOOL DISTRICT
EDUCATIONAL INFORMATION ON FOSTER AND PROBATION YOUTH. BETWEEN
OUR SOCIAL WORKERS, THE COURT, THE ATTORNEYS, WHEN PARENTAL

CONSENT IS UNABLE TO BE OBTAINED. SHE DEVELOPED A FOSTER
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PROBATION YOUTH DEVELOPMENT ENROLLMENT LETTER THAT STREAMLINED
AND EXPEDITED THE ENROLLMENT PROCESS, EVEN ABSENT TRANSCRIPTS
OR RECORDS FROM THE PREVIOUS SCHOOLS. AS A RESULT, 87 PERCENT
OF OUR FOSTER AND PROBATION YOUTH IN LICENSED OUT-OF-HOME CARE
FACILITIES HAVE NOW BEEN ENROLLED WITHIN SCHOOLS WITHIN THE
REQUIRED 72-HOUR TIME FRAME. SHE ALSO CONDUCTED DATA MATCHES
BETWEEN THE D.C.F.S., PROBATION AND NINE OF OUR SCHOOL
CAMPUSES. I SHOULD SAY NINE SCHOOL DISTRICTS. AND THESE
INCLUDED IDENTIFYING THE YOUTH WITHIN EACH SCHOOL DISTRICT
WITH THEIR ACADEMIC ACHIEVEMENT, REVEALED THOSE SCHOOLS WHERE
TARGETED ACADEMIC ENRICHMENT PROGRAMS FOR SYSTEM YOUTH WOULD
YIELD THE HIGHEST BENEFIT AND PROVIDED THE STATISTICAL
COMPARISONS OVER THE TIME ON THE IMPACTS OF TARGETED SCHOOL
PROGRAMS AND ACTIVITIES. AND SHE ASSISTED IN CREATING, AND I
HAVE WITH ME RIGHT HERE THE GLORIA MOLINA FOSTER YOUTH
EDUCATIONAL PROGRAM, THIS LITTLE GREEN BOOKLET WHICH IS
ASSISTING FOSTER YOUTH IN THE MONTEBELLO AND POMONA SCHOOL
DISTRICTS TO IMPROVE THEIR G.P.A. FOR D.C.F.S. BY 25 PERCENT,
RECOVERED OVER 1,000 COURSE CREDITS AND RESULTED IN 76 PERCENT
OF PILOT STUDENTS GRADUATING FROM THE HIGH SCHOOL, 77 PERCENT
WHO ARE NOW ENROLLED IN COLLEGE. SO WE WANT TO THANK YOU FOR
YOUR VISION AND YOUR LEADERSHIP AND WELCOME YOU ABOARD AND
WORKING WITH THE COUNTY'S OFFICE NOW TO MOVE FORWARD TO HELP
MORE OF OUR YOUNG PEOPLE ATTAIN THESE SAME POSITIVE RESULTS

THAT YOU CREATED FOR THESE OTHER CHILDREN. [APPLAUSE. ]
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CARRIE MILLER: THANK YOU SO MUCH. I REALLY APPRECIATE IT. I'M
VERY PROUD OF THE WORK THAT THE COUNCIL HAS DONE OVER THE LAST
FIVE YEARS IN EXISTENCE. IT WAS A REALLY WONDERFUL OPPORTUNITY
FOR THE COUNTY TO COME TOGETHER, FOR THE BOARD OF SUPERVISORS
TO CREATE THIS COUNCIL, WHICH HAS REALLY LED TO IMPROVED
EDUCATIONAL OPPORTUNITIES FOR FOSTER AND PROBATION YOUTH. I'M
SO PROUD OF THE WORK THAT WE'VE DONE SO FAR IN THE LAST FIVE
YEARS. AND I'M EVEN MORE PROUD OF WHERE I THINK THE COUNCIL'S
GOING TO GO IN THE FUTURE UNDER THE LEADERSHIP OF TRISH
PLOEHN. IT'S REALLY READY TO STEP UP TO THE NEXT LEVEL AND
MAKE SURE THAT WE HELP EVEN MORE FOSTER AND PROBATION YOUTH.
AND I'M REALLY EXCITED TO SEE WHERE THAT GOES AND WATCH THE
GROWTH HAPPEN. SO THANK YOU SO MUCH FOR THIS. I APPRECIATE IT.

[APPLAUSE. ]

SUP. ANTONOVICH, MAYOR: NOW WE WANT TO INTRODUCE THE MEMBERS
OF THE SAUGUS HIGH SCHOOL GIRLS AND BOYS CROSS COUNTRY TEAM.
BILL BOLDE, THE PRINCIPAL, AND RENE PARAGAS, THE HEAD COACH.
BY NOW SPORTS FANS WHO DON'T FOLLOW CROSS COUNTRY ARE PROBABLY
FAMILIAR WITH THE SAUGUS GIRLS' CROSS COUNTRY TEAM. THEY HAVE
BEEN HERE YEAR AFTER YEAR BECAUSE THEY'VE BEEN THE CHAMPIONS.
THEY HAVE WON THEIR FIFTH STRAIGHT C.I.F. STATE CHAMPIONSHIP
AND THEIR FIRST SUCH RUN IN GIRLS' STATE HISTORY. THEY HAVE

BROKEN THE STATE RECORD FOR THE FASTEST TEAM THREE TIMES. THEY
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1 COMBINED TO RUN THE DIVISION II RACE IN 89 MINUTES, 25

2 SECONDS, SWEEPING ASIDE THE 2008 TEAM RECORD OF 90 MINUTES AND
3 SIX SECONDS. BREAKING THE 90-MINUTE BARRIER IS SOMETHING THAT
4 MEET OFFICIALS ADMITTED THEY DIDN'T EVER THINK COULD HAPPEN.

5 THAT'S BECAUSE YOU GOT RID OF JUNK FOOD, ARE RIGHT? MORE

6 VEGETABLES? IS THAT WHAT DID IT?

8§ RENE PARAGAS: A LOT OF PASTA.

10 SUP. ANTONOVICH, MAYOR: A LOT OF PASTA. THE TEAM ALSO

11 ACCOMPLISHED ANOTHER FEAT BY HAVING ONE TEAM THAT HAD ALL FIVE
12 OF ITS SCORES IN THE TOP 10. SO WE WANT TO CONGRATULATE THEM.
13 [APPLAUSE.] THEN THE BOYS' TEAM, THEY CAME UP SHORT IN THEIR
14 BID TO JOIN THE GIRLS AS STATE CHAMPIONS. THEY FINISHED SECOND
15 IN DIVISION II. THEY STILL WON THE C.I.F. SOUTHERN SECTION

16 DIVISION IN TITLE 2, FINISHING HIGHER AT THE STATE MEET THAN
17 ANY OF THE BOYS' TEAMS BEFORE THEM. SAUGUS QUALIFIED FOR BACK-
18 TO-BACK STATE MEETS FOR THE FIRST TIME IN MORE THAN A DECADE.
19 THEY WON THE FOOTHILL LEAGUE FOR THE FIFTH YEAR IN A ROW. THE
20 SAUGUS TEAM, THE CROSS COUNTRY PROGRAM BETWEEN 2006 AND 2010
21 JOINS THE ARGUMENT AS ONE OF THE GREATEST TEAMS IN THE HISTORY
22 OF THE SANTA CLARITA VALLEY HISTORY OF ATHLETES. SO WE LOOK
FORWARD TO MANY MORE SUCCESSEFUL SEASONS AND WELCOMING THE
GIRLS BACK AGAIN, AND THE BOYS AGAIN, TO GET YOUR GOLD, YOUR

LITTLE EMMY FOR THE GOOD WORK YOU'VE DONE. AND YOU HAVE A GOOD
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1 PRINCIPAL, GOOD COACHES AND WE JUST WISH YOU CONGRATULATIONS.
2 SO LET ME GIVE THIS TO THE BOYS AND WE'LL TAKE A GROUP

3 PICTURE. [APPLAUSE.] LET ME ASK THE PRINCIPAL FIRST TO SAY A
4 FEW WORDS AND THEN THE COACH AND THEN WE'LL DO THE GROUP

5 PICTURES.

7 BILL BOLDE: SUPERVISOR ANTONOVICH, IT IS A PLEASURE TO BE HERE
8 AGAIN, AS WE HAVE FOR THE LAST FOUR YEARS. AND YOU KNOW, WE

9 NEVER GET TIRED OF COMING DOWN HERE BECAUSE THIS IS MORE THAN
10 JUST AN ATHLETICS THING. THIS IS AN OPPORTUNITY FOR THESE

11 YOUNG LADIES AND YOUNG MEN TO HAVE AN OPPORTUNITY TO SEE WHAT
12 GOVERNMENT'S LIKE IN ACTION. I WANTED TO JUST COMMEND YOU FOR
13 YOUR CONTINUING SERVICE IN OUR COMMUNITY. AND I WANT TO

14 SPECIFICALLY SAY THANK YOU FOR THIS GREAT STAFF YOU HAVE UP IN
15 SANTA CLARITA. WORKING WITH ROSLYN AND DAVID PERRY, THEY ARE
16 OUTSTANDING INDIVIDUALS. IT IS JUST EXCITING TO KNOW THAT THEY
17 ARE CLOSE BY AND THEY'RE A PHONE CALL AWAY TO HELP US WITH

18 MANY DIFFERENT THINGS. SO THANK YOU FOR THAT SUPPORT. BUT WE
19 ARE HERE AGAIN. AND WE'RE DELIGHTED TO BE HERE. BUT ALL

20 PRINCIPALS KNOW THAT A SCHOOL OF EXCELLENCE IS ONLY AS GOOD AS
21 THE PEOPLE OF EXCELLENCE THAT YOU HAVE IN FRONT OF YOU. SO
WHEN I LOOK AT AN ATHLETIC DIRECTOR, MARCUS GARRETT DOWN HERE,
AND LOOK AT CATHERINE NELSON, OUR ASSISTANT COACH, I'M VERY
GRATEFUL FOR WHAT THEY DO. AND I'VE LEFT KIND OF THE LAST

PERSON, OUR HEAD COACH, BECAUSE I'VE GOT TO SAY A COUPLE
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1 THINGS FOR THEM, FOR THIS INDIVIDUAL. RENE WILL GET UP HERE IN
2 JUST A MINUTE AND HE WILL TELL YOU WHAT GREAT THINGS THESE

3 KIDS DO. AND CERTAINLY THEY HAVE LEARNED HOW TO RUN FAST. AND
4 CERTAINLY THEY ARE SOME OF THE MOST OUTSTANDING STUDENTS

5 YOU'LL EVER GET A CHANCE TO SEE. SOME OF THEM ARE GOING TO

6 UNIVERSITIES LIKE COLUMBIA. THEY'RE UP FOR STANFORD, ARIZONA,
7 OLD MISS, AND THEN MANY OF THEM HAVEN'T COMMITTED YET. BUT

8 EVERY ONE OF THESE ARE COMMITTED TO GOING TO FOUR-YEAR

9 COLLEGES AND ADVANCING THEIR EDUCATION, BECAUSE THEY KNOW

10 THAT'S WHERE THE FUTURE LIES FOR THEM. BUT RENE PARAGAS, I'M
11 GOING TO EMBARRASS HIM, AS I ALWAYS DO. HE IS MORE THAN A

12 COACH TO THESE KIDS. HE IS A TEACHER OF LIFE. AND I THINK

13 THAT'S IMPORTANT FOR ALL TEACHERS TO KNOW ABOUT. RENE PARAGAS
14 SPENDS HOURS AND HOURS AND HOURS WITH THEM, NOT JUST TEACHING
15 THEM HOW TO RUN, BUT HOW TO CONDUCT THEMSELVES AS INDIVIDUALS.
16 IN OUR COMMUNITY THEY REPRESENT OUR SCHOOL WITH PRIDE,

17 CHARACTER AND DIGNITY BECAUSE THAT'S HOW HE CARRIES HIMSELF.

18 MOST PEOPLE DON'T KNOW THAT HE IS A TEACHER OF THE YEAR IN OUR
19 DISTRICT. AND THAT IS SOMETHING I THINK HE WOULD TELL YOU, YOU
20 TAKE ALL THE AWARDS AND ALL THE CHAMPIONSHIPS, HE'S MAKING AN
21 IMPACT ON THE LIVES OF OVER 200 KIDS EVERY SEMESTER ON OUR
CAMPUS, NOT JUST THOSE THAT RUN FOR HIM. TO EACH AND EVERY ONE
OF YOU WHO ARE RUNNING AND GOING ON TO COLLEGE, I CONGRATULATE
YOU, I COMMEND YOU, I THANK YOU FOR YOUR DILIGENCE. BUT TODAY

I ALSO WANT TO TAKE A MOMENT TO EMBARRASS MR. PARAGAS, BECAUSE
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1 HE IS WHAT OUR CROSS COUNTRY IS ALL ABOUT. THE ONE CONSTANT
2 THROUGH ALL THE YEARS HAS BEEN HIM. CONGRATULATIONS, MR.

3 PARAGAS. [APPLAUSE.]

5 RENE PARAGAS: WELL, THAT'S A BIG INTRO. I THANK YOU FOR SAYING
6 THOSE NICE THINGS ABOUT ME, AND I'D LIKE TO THANK SUPERVISOR

7 ANTONOVICH FOR HAVING US AGAIN. AND JUST ECHOING THE THINGS

8 THAT PRINCIPAL BOLDE SAID ABOUT THE ATHLETES HERE, IS THAT WE
9 ARE CERTAINLY SUCCESSFUL ON THE ATHLETIC FIELD, BUT IN THE

10 CLASSROOM, AS PEOPLE, WE HAVE GROWN A LOT TOGETHER. AND WE'VE
11  HAD A LOT OF FUN DOING IT. AND IT'S GREAT BEING HERE. AND

12 HOPEFULLY WE'RE BACK HERE NEXT YEAR, AS WELL. SO THANK YOU.

13 [APPLAUSE.]

14

15 RENE PARAGAS: THIS IS THE ONE GOING TO COLUMBIA. THANK YOU SO
16 MUCH.

17

18 SUP. ANTONOVICH, MAYOR: YOU'RE WELCOME. THIS IS A LITTLE BOY.
19 HE'S NINE MONTHS OLD, SPANKY, WHO IS LOOKING FOR A HOME. DO

20  YOU WANT SPANKY? HERE HE IS IF YOU -- HE'D LIKE TO RUN WITH

21  YOU GUYS. ANYBODY LIKE TO ADOPT LITTLE SPANKY? YOU CAN CALL
THE TELEPHONE NUMBER 562-728-4644. (OFF MIC.) AND HOW ABOUT
VINCE? VINCE NEEDS A DOG. YEAH, HE'S LOOKING THE OTHER WAY. DO

YOU HAVE ANY PROCLAMATIONS, GLORIA? DO YOU HAVE A
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1 PROCLAMATION? ANY SCROLLS? SUPERVISOR MARK RIDLEY-THOMAS, ANY

2 PRESENTATIONS? OKAY, ADJOURNMENTS?

4 SUP. KNABE: THANK YOU, MEMBERS OF THE BOARD, MR. MAYOR, LADIES
5 AND GENTLEMEN, I HAVE A NUMBER OF ADJOURNMENTS SINCE I WAS NOT
6 HERE LAST WEEK. FIRST OF ALL THAT WE ADJOURN IN MEMORY OF

7 JOYCE ELIZABETH TOWNSEND, BETTER KNOWN AS GRANDMA JOY, WHO

8 PASSED AWAY PEACEFULLY ON JANUARY 22 AT THE AGE OF 93. A

9 DEVOTED WIFE, LOVING MOTHER, GRANDMOTHER AND GREAT

10 GRANDMOTHER. A SUBSTITUTE TEACHER FOR OVER 30 YEARS AND

11 DEVOTED OVER 10,000 HOURS AT THE CHILDREN'S HOSPITAL OF ORANGE
12 COUNTY AS A VOLUNTEER. SHE GRADUATED FROM HIGH SCHOOL AND WENT
13 ON TO U.C.L.A., AND UPON GRADUATING FROM U.C.L.A., SHE WENT TO
14 WORK FOR DOUGLAS AIRCRAFT IN SANTA MONICA, BECAME ONE OF THE
15 MAJOR WORLD WAR II FACTORIES IN PART OF THE ROSIE THE RIVETER
16 PROGRAM. SHE LEAVES BEHIND HER SON, CRAIG; A DAUGHTER-IN-LAW,
17 DEBRA; GRANDDAUGHTER, CARLYE; DAUGHTER, DIANE, BETTER KNOWN AS
18 DEDE, GRANDMA DEDE BLACKMAN; GRANDDAUGHTERS, ERIN; HUSBAND

19 JOHN; GREAT GRANDSONS, CARSON AND BRETT; JENNIFER; HUSBAND

20 RICHARD; AND GREAT GRANDDAUGHTER, RILEY; AND THEN

21 GRANDDAUGHTER, BRIANNA JOY KNABE AND HUSBAND MATT; GREAT
GRANDSON, KADEN; AND GREAT GRANDDAUGHTER, WHO WAS JUST BORN A
FEW WEEKS AGO AND TOOK ON HER NAME IN THE CIRCLE OF LIFE,
KYLA. SHE WILL BE MISSED BY ALL. SHE WAS A GREAT LADY AND HAD

A WONDERFUL LIFE. ALSO THAT WE ADJOURN IN MEMORY OF RANDOLPH
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DILDAY, WHO PASSED AWAY SUDDENLY AT THE AGE OF 59, A MEMBER OF

A VERY PROMINENT LONG BEACH FAMILY, WAS BORN IN LONG BEACH,
GRADUATED FROM POLY, WENT ON TO THE UNIVERSITY OF OREGON.

FOURTH GENERATION MEMBER OF ONE OF LONG BEACH'S PIONEERING

FAMILIES THAT PUT DOWN ROOTS IN LONG BEACH IN 1916. AS MANY OF

YOU KNOW, THEIR HISTORY WAS THE MORTUARY BUSINESS. BUT
RANDOLPH FORGED A 30-YEAR CAREER AS A FINANCIAL ADVISOR,

WRITER AND INVENTOR AND SPENT A LOT OF TIME BETWEEN HERE AND

WASHINGTON. HE HAD MANY INTERESTS, INCLUDING BOTANY, GUARDING,

BOATING, AND INVENTIONS, GREEN LIFESTYLE, HIKING, PLAYING

MUSIC AND COMPOSING. HE WILL BE MISSED BY ALL. HE'S SURVIVED

BY WIFE, CHILDREN, DORRIE; TWO CHILDREN, RANDOLPH AND HANNAH;

AND SIBLINGS, PAMELA, JACK, STEVE; AND MANY OTHER FAMILY
MEMBERS. HE WILL BE MISSED BY ALL. ALSO WE ADJOURN IN MEMORY
OF CARMEN VARELA HEWS, MOTHER OF BRIAN HEWS WHO WAS THE
PUBLISHER OF THE CERRITOS COMMUNITY NEWS, WHO PASSED AWAY

RECENTLY AT THE AGE OF 90. SHE WAS THE OLDEST OF 11 BROTHERS

AND SISTERS, GREW UP IN MEXICO, STARTED A WEDDING DRESS MAKING

BUSINESS IN TIJUANA. LATER ON MOVED TO CALIFORNIA HERE IN

HOLLYWOOD, WHERE SHE WOULD MEET AND MARRY HER FUTURE HUSBAND,

ART. SHE WILL BE DESPERATELY MISSED. SHE IS SURVIVED BY HER
THREE SONS, EDWARD, JAMES AND BRIAN; SIX GRANDCHILDREN; AND

TWO GREAT GRANDCHILDREN. ALSO AFTER A LENGTHY ILLNESS, HANS

TAUCHER PASSED AWAY ON JANUARY 22, HE WAS JUST 54. GREW UP IN

BELMONT SHORE. OPERATING A SHORE SPORTING GOODS STORE, A
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FIXTURE DOWN IN LONG BEACH. HE GRADUATED FROM WILSON HIGH
SCHOOL, HAD A LONG CAREER AS A COMMERCIAL BUILDING CONTRACTOR
AND CONSTRUCTION MANAGEMENT ALL OVER SOUTHERN CALIFORNIA. HE
WAS A HARD WORKING, CARING MAN WHO WILL BE MISSED. HE IS
SURVIVED BY HIS WIFE, LINDA; SON, SCOTT; MOTHER, WILLIE; AND
BROTHER, CURT. ALSO THAT WE ADJOURN IN MEMORY OF GERALD
MULROONEY, A FORMER MAYOR OF PARAMOUNT WHO PASSED AWAY
RECENTLY. HE WAS ON THE CITY COUNCIL FROM 1980 TO 1996. HE
HELPED HIS PARENTS OPEN WESTERN AUTO SUPPLY AND HARDWARE. HE
WENT ON TO BECOME A VERY FAMOUS BIKER AND HAD THE MULROONEY
BIKE SHOP FOR YEARS. HE LOVED TO PLAY GOLF, TRAVEL, FISH AND
PLAY BRIDGE. HE WILL BE MISSED BY ALL. JUST A GREAT GUY. HE
WAS ON THE CITY COUNCIL WHEN I WAS ON CITY COUNCIL IN
CERRITOS. SURVIVED BY HIS WIFE OF 55 YEARS, NANCY; THREE
CHILDREN, SIX GRANDCHILDREN, AND MANY FRIENDS AND RELATIVES.
ALSO TO ADJOURN IN MEMORY OF JOHN DEACON, A MEMBER OF MY
CERRITOS OPTIMISTS CLUB AND FORMER PRESIDENT, WHO PASSED AWAY
SUDDENLY ON JANUARY 22. HE IS SURVIVED BY HIS WIFE, LAURA, TWO
CHILDREN, AND SIX SIBLINGS. ALSO WE ADJOURN IN MEMORY OF LEE
ROY WARE, THE FIRST MAYOR OF THE CITY OF HAWAIIAN GARDENS. HE
WORKED AT DOUGLAS AIRCRAFT DURING WORLD WAR II. HE HELPED
INCORPORATE AND BECAME THE FIRST MAYOR, AS I SAID, IN HAWAIIAN
GARDENS. A PARK WAS NAMED IN HIS HONOR. HE WAS VERY ACTIVE IN
HIS COMMUNITY, INCLUDING THE LIONS CLUB, BOY SCOUT LEADER AND

TEACHER AT EMMANUEL BAPTIST CHURCH. SURVIVED BY HIS SISTER,
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1 ELTIZABETH; THREE GRANDCHILDREN, 11 GREAT GRANDCHILDREN. AND HE
2 HAD ONE STEP GREAT, GREAT, GREAT GRANDCHILD. ALSO THAT WE

3 ADJOURN IN MEMORY OF WAYNE UYEMATSU OF CERRITOS. BORN IN

4 HAWAII, MOVED TO L.A. IN '59. HE WAS VERY INVOLVED IN

5 CHILDREN'S SPORTS ACTIVITIES. HE WAS A HANDYMAN. ENJOYED

6 EVERYTHING FROM GOLE TO WOODWORKING TO BUILDING. HE HAD A

7 GREAT SENSE OF HUMOR AND A VERY INFECTIOUS SMILE. HE IS

8 SURVIVED BY HIS WIFE OF 40 YEARS, PATSY; TWO CHILDREN, TWO

9 GRANDSONS, AND TWO SIBLINGS. ALSO WE ADJOURN IN MEMORY OF

10 PEGGY SMITH, WHO PASSED AWAY PEACEFULLY AT HER LAKEWOOD HOME
11 AT THE AGE OF 78. SHE IS SURVIVED BY HER HUSBAND, JACK, TWO

12 CHILDREN, FOUR GRANDCHILDREN AND FIVE GREAT GRANDCHILDREN, A
13 SISTER AND A BROTHER. ALSO THAT WE ADJOURN IN MEMORY OF ROBERT
14 ALLEN MORRISON, A LONGTIME RESIDENT OF BELMONT SHORE, WHO

15 PASSED AWAY AT THE AGE OF 83. HE RETIRED FROM LOCKHEED MARTIN
16 IN 1990 AND FORMED HIS OWN COMPANY, INDEVCO, WHERE HE HELD

17  MORE THAN 75 PATENTS IN AVIONICS AND AEROSPACE. HE SERVED IN
18 THE UNITED STATES NAVY. HE VOLUNTEERED AT RANCHO LOS AMIGOS

19 HOSPITAL. HE HAD A GREAT SENSE OF HUMOR. HE IS SURVIVED BY HIS
20 WIFE, GAIL; FOR SONS, THREE STEPCHILDREN AND 11 GRANDCHILDREN,
21 AND A SISTER. ALSO THAT WE ADJOURN IN MEMORY OF DAVID

22  ALEXANDER, A MAGICIAN, AUTHOR, SKEPTICS SOCIETY ADVISOR, AND
SILHOUETTE ARTIST, WHO PASSED AWAY RECENTLY. BORN IN LONG
BEACH, GREW UP IN LAKEWOOD. HE WROTE THE AUTHORIZED BIOGRAPHY

OF GENE RODDENBERRY, "STAR TREK CREATOR" AND WAS EDITOR OF THE
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HUMANIST FROM SEPTEMBER OF 'S0 TO DECEMBER OF 1991. HE

SURVIVED BY HIS WIFE OF 34 YEARS, PENNY. AND FINALLY THAT WE
ADJOURN IN MEMORY OF HERMAN ALEVY, A RESIDENT OF LONG BEACH
FOR OVER 65 YEARS, WORLD WAR II VETERAN. SETTLED IN LONG BEACH
AND THEN MOVED TO THE NEW LAKEWOOD COMMUNITY IN 1951. HE WAS
AN ACTIVE LOCAL AND LEADER WITH THE LONG BEACH POSTAL CREDIT
UNION AND THE NATIONAL ASSOCIATION OF LETTER CARRIERS AND
CHAIRED THE UNION'S NATIONAL HEALTH BENEFIT COMMITTEE. HE IS
SURVIVED BY HIS TWO CHILDREN, GAIL AND SCOTT. MR. MAYOR. THOSE

ARE MY ADJOURNMENTS.

SUP. ANTONOVICH, MAYOR: SECOND WITHOUT OBJECTION, SO ORDERED.

SUP. KNABE: I DON'T THINK I HELD ANYTHING. BUT ON ITEM NO. 42,
THERE ARE A NUMBER OF PEOPLE THAT HAVE SIGNED UP TO SPEAK. AND

I THINK WE CAN CALL ITEM 42 UP.

CLERK SACHI HAMAI: MR. MAYOR, MEMBERS OF THE BOARD, THIS IS A
PUBLIC HEARING ITEM AND I'LL READ THE SHORT TITLE IN FOR THE
RECORD. AND THEN IF WE COULD SWEAR EVERYBODY IN. THIS IS THE
DE NOVO HEARING ON PROJECT NO. R2009-02277-(4) RELATING TO THE
RECOMMENDATIONS OF THE REGIONAL PLANNING COMMISSION TO ADOPT
AN AGGREGATE MAP AND TEXT AMENDMENT TO THE MARINA DEL REY
LOCAL COASTAL PROGRAM PERTAINING TO THE PIPELINE PROJECTS,

SENSITIVE BIOLOGICAL RESOURCES, OPEN SPACE, PUBLIC PARKING,
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1 AND BOAT SLIPS ALL RELATED TO LAND USES IN THE UNINCORPORATED
2 COMMUNITY OF MARINA DEL REY, IN THE PLAYA DEL REY ZONE

3 DISTRICT, AND SUBMIT THE AMENDED MARINA DEL REY L.C.P. TO THE
4 CALIFORNIA COASTAL COMMISSION. SO ON THIS ITEM, ALL THOSE WHO
5 PLAN TO 